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Work Area 9 ICT SKILLS

4.9 USING SPREADSHEETS TO PRODUCE NON-ROUTINE 
COMPLEX SHEETS

• LO112: Demonstrate skills in using Spreadsheet software at an 
advanced level to produce complex worksheets that conform to 
agreed specifications. Take some responsibility for the evaluation of 
the result
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Unit Title: USE SPREADSHEETS TO PRODUCE NON-ROUTINE COMPLEX SHEETS

Learning Outcomes Nos: LO112

Learning Outcomes titles: Demonstrate skills in using Spreadsheet software at an advanced level to produce 
complex worksheets that conform to agreed specifications. Take some 
responsibility for the evaluation of the result

Recommended Duration: 3 hours

Trainer:
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Specialized Operating Functions 

This lesson has 3 objective points.

A. Each one of you to come across with the most influential
functions needed in a spreadsheet. This means Advanced
Formulas and Functions like:

1. What If Analysis

2. Complex Formulas (Embedded if’s etc.)

3. And or Or functions

4. Financial Functions

5. Text Functions

6. Advanced Filtering
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Specialized Operating Functions 

B. The knowledge of Protecting a Spreadsheet:

1. The know How

2. Some Advanced Properties in a spreadsheet

3. How to Recognize Errors in Functions and Formulas

C. In a certain Case Study, the production of the appropriate
Functions needed and the selection of them will be produced by
the users knowledge in a smooth and automated way:

1. Selection of the proper formulas per case

2. Automatic import of a function

3. Check of the results

4. Advanced charts and the tools needed in order to construct
these charts
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More on Functions….

I know that most of you are dying to learn more about Functions 
and advanced formulas, protection of spreadsheets and so on.

But we are going to talk about them …. 

In the next lecture….
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Target of Knowledge

We are going to analyze 5 major sections in a spreadsheet.

1. “What if” Analysis

2. Complex Formulas

3. And or Or Function

4. A Financial Function

5. An advanced Filtering 

Upon finishing this unit all participants would be able to 

create advanced formulas and functions in a 

spreadsheet.
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What if Analysis

What does it do:

Well, What-If Analysis in Excel allows you to try out 

different values (scenarios) for formulas. 

The following example helps you master what-if analysis 

quickly and easily.

Lets try it out together.
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Data Entry
There are two ways to enter information into a cell:

1. Type directly into the 
cell.
Click on a cell, and type in 
the data (numbers or text) 
and press Enter.

2. Type into the formula 
bar.
Click on a cell, and then 
click in the formula bar (the 
space next to the).  Now 
type the data into the bar 
and press Enter.
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What if Analysis

Assume you own a book store and have 100 books in 

storage. You sell a certain % for the highest price of 50 €

and a certain % for the lower price of 20 €.

So lets make the next sheet by entering the data above.
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What if Analysis

If you sell 60% for the highest price, cell D10 calculates 

a total profit of 60 * 50 € + 40 * 20 € = 3800 €.
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What if Analysis

Create Different Scenarios

But what if you sell 70% for the highest price? And what if 

you sell 80% for the highest price? Or 90%, or even 100%? 

Each different percentage is a different scenario. 

You can use the Scenario Manager to create these 

scenarios.

You can simply type in a different percentage into cell C4 to 

see the corresponding result of a scenario in cell D10. 

However, what-if analysis enables you to easily compare the 

results of different scenarios. So far so good. 

Lets now see some steps for creating scenarios
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What if Analysis – Different Scenarios

Step 1. On the Data tab, in the Forecast group, click 

What-If Analysis.

Step 2. Click Scenario Manager.
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What if Analysis – Different Scenarios

The Scenario Manager 

dialog box appears.

Step 3. Add a scenario 

by clicking on Add.
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What if Analysis – Different Scenarios

Step 4. Type a name 

(60% highest), select 

cell C4 (% sold for 

the highest price) for 

the Changing cells 

and click on OK.
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What if Analysis – Different Scenarios

Step 5. Enter the 

corresponding value 

0.6 and click on OK 

again.
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What if Analysis – Different Scenarios

Step 6. Next, add 4 

other scenarios 

(70%, 80%, 90% and 

100%).

Finally, your Scenario 

Manager should be 

consistent with the 

picture below:
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What if Analysis – Different Scenarios

In order to see the result of a scenario, select the scenario 

and click on the Show button. Excel will change the value 

of cell C4 accordingly for you to see the corresponding 

result on the sheet.



This project has been funded with support from the 

European Union. This [project] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein

.

What if Analysis – Different Scenarios

Scenario Summary

To easily compare the 

results of these 

scenarios, execute the 

following steps.

1. Click the Summary 

button in the Scenario 

Manager.

2. Next, select cell D10 

(total profit) for the result 

cell and click on OK.
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What if Analysis – Different Scenarios

And the result is………

For conclusion:

If you sell 70% for the highest price, you obtain a total 

profit of 4100 €, if you sell 80% for the highest price, you 

obtain a total profit of 4400 €, etc. 
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What if Analysis – Different Scenarios

This is What if analysis looks like….

and that’s how simple it can be to a spreadsheet. 
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Complex Formulas

A simple formula is a mathematical expression with one 

operator, such as 7+9. A complex formula has more than 

one mathematical operator, such as 5+2*8. When there is 

more than one operation in a formula, the order of 

operations tells your spreadsheet which operation to 

calculate first. In order to use complex formulas, you will 

need to understand the order of operations.
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Complex Formulas

The order of operations
All spreadsheet programs calculate formulas based on the 

following order of operations:

1. Operations enclosed in parentheses

2. Exponential calculations (3^2, for example)

3. Multiplication and division, whichever comes first

4. Addition and subtraction, whichever comes first

A mnemonic that can help you remember the order 

is PEMDAS,  or

Please Excuse My Dear Aunt Sally.
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Complex Formulas
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Complex Formulas
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Creating complex formulas

Lets demonstrate a complex formula using the 

order of operations. 

Here, we want to calculate the cost of sales tax for

a catering invoice. To do this, we'll write our formula

as

=(D2+D3)*0.075

in cell D4. This formula will add the prices of our

items together and then multiply that value by the

7.5% tax rate (which is written as 0.075) to

calculate the cost of sales tax.
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Creating complex formulas

The spreadsheet then follows the order of

operations and first adds the values inside the

parentheses:

(44.85+39.90) = $84.75

Then it multiplies that value by the tax

rate: $84.75*0.075. The result will show that the

sales tax is $6.36.
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Creating complex formulas

Caution: If you do 

that in a wrong way, 

meaning that you 

forget the 

parenthesis or 

change 

multiplication row 

and so on , you will 

get a wrong result 

also. 
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To create a complex formula using the order of operations

In our example below, we will use cell references along with numerical 

values to create a complex formula that will calculate the total cost for a 

catering invoice. The formula will calculate the cost for each menu item and 

add those values together. Lets see some steps producing a complex 

formula

Step 1: Select the cell that will contain the formula. In our example, we'll 

select cell C4.

Creating complex formulas
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Creating complex formulas

Step 2: Enter your formula. In our example, we'll type =B2*C2+B3*C3.

This formula will follow the order of operations, first performing

multiplication: 2.29*20 = 45.80 and 3.49*35 = 122.15. Then it will add

those values together to calculate the total: 45.80+122.15.

Step 3: Double-check your formula for accuracy, then press Enter on your 

keyboard. The formula will calculate and display the result. In our 

example, the result shows that the total cost for the order is $167.95.
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Creating complex formulas

Notice: You can add parentheses to any equation to make it easier to 

read. While it won't change the result of the formula in this example, we 

could enclose the multiplication operations within parentheses to clarify 

that they will be calculated before the addition.
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More on Creating complex formulas

Nested If

The IF function in Excel can be nested, when you have multiple

conditions to meet. The FALSE value is being replaced by another IF

function to make a further test.

Before we continue lets see an example using the if function.

Example using IF Function:

“The scores of some students are given in a table along with their 

names. Now for finding the Result of these students, we can use 

an IF statement. As you can see in the above image I have also 

defined the Pass and Fail criteria for these students.

Sores above 50 are considered PASS, while scores that are 

below or equal to 50 are considered FAIL.”
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In this scenario we can use a formula:

=IF(B2<=50,"Fail","Pass")

seeing in the picture below.

More on Creating complex formulas
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Now, what this means. 

This formula means that first we are comparing the number 

at B2 i.e. 37 (Score of First Student) with our condition. 

This expression boils down to (37 <= 50) i.e. Is 37 less than 

or equal to 50, which is True. 

Hence the result will be ‘Value_if_True’ (second parameter 

of if statement) i.e. “Fail”.

Similarly, for the second student the formula will be:

=IF(B3<=50,"Fail","Pass")

etc.

More on Creating complex formulas
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More on Creating complex formulas

Example Using Nested IF Functions

Now lets concentrate on embedded If’s 

Step 1a: If cell A1 equals 1, the formula returns Bad.
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More on Creating complex formulas

Step 1b: If cell A1 equals 2, the formula returns Good.

Step1c: If cell A1 equals 3, the formula returns Excellent.
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More on Creating complex formulas

Step 1d: If cell A1 equals another value, the formula returns 

No Valid Score.
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More on Creating complex formulas

Let’s take a look on another example.

Step 2a: If cell A1 is less or equal to 10, the formula 

returns 350.
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More on Creating complex formulas

Step 2b: If cell A1 is greater than 10 and less or equal 

to 20, the formula returns 700.

Or…..
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More on Creating complex formulas

Step 2c: If cell A1 is greater than 20 and less or equal 

to 30, the formula returns 1400.

Step 2d: If cell A1 is greater than 30, the formula returns 2000.
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AND and OR function

Now that we have reached this point of extreme 

knowledge… let’s take a look how to enrich our Excel If 

Functions with AND or OR logical operators.

Microsoft Excel provides 4 logical functions to work with the 

logical values. The functions are AND, OR, XOR and NOT. 

You use these functions when you want to carry out more 

than one comparison in your formula or test multiple 

conditions instead of just one. As well as logical operators, 

Excel logical functions return either TRUE or FALSE when 

their arguments are evaluated.
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AND and OR function

The table 

aside provides 

a short 

summary of 

what each 

logical 

function does 

to help you 

choose the 

right formula 

for a specific 

task.
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The AND function

The AND function is the most popular member of the logic 

functions family. It comes in handy when you have to test 

several conditions and make sure that all of them are met. 

Technically, the AND function tests the conditions you 

specify and returns TRUE if all of the conditions evaluate 

to TRUE, FALSE otherwise.

The syntax for the Excel AND function is as follows:

Where logical is the condition you want to test that can 

evaluate to either TRUE or FALSE. The first condition 

(logical1) is required, subsequent conditions are optional.
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The AND function

Since you got that, let's look at some formula examples that 

demonstrate how to use the AND functions in Excel formulas.
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The AND function

And in an Excel sheet…
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The AND function - Common Uses

By itself, the Excel AND function is not very exciting and 

has narrow usefulness. 

But in combination with other Excel functions, AND can 

significantly extend the capabilities of your worksheets.

One of the most common uses of the Excel AND function 

is found in the logical_test argument of the IF function to 

test several conditions instead of just one. For example, 

you can nest any of the AND functions above inside the IF 

function and get a result similar to this:

=IF(AND(A2="Bananas", B2>C2), "Good", "Bad")
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The AND function - Common Uses

And in an Excel sheet…
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The OR function

As well as AND, the Excel OR function is a basic logical 

function that is used to compare two values or statements.

The difference is that the OR function returns TRUE if at 

least one if the arguments evaluates to TRUE, and returns 

FALSE if all arguments are FALSE. 

The OR function is available in all versions of Excel 2000 –

20XX.
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The OR function

The syntax of the Excel OR function is very similar to AND:

Where logical is something you want to test that can be 

either TRUE or FALSE. The first logical is required, 

additional conditions are optional.
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The OR function

Since you got that too, let's look at some formula 

examples that demonstrate how to use the OR functions in 

Excel formulas.
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The OR function

And in an Excel sheet…
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The AND and OR function – Together

As well as Excel AND function, OR is widely used to 

expand the usefulness of other Excel functions that 

perform logical tests, e.g. the IF function. Here are just a 

couple of examples:
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IF function with nested OR

=IF(OR(B2>30, C2>20), "Good", "Bad")

The formula returns "Good" if a number in cell B3 is greater 

than 30 or the number in C2 is greater than 20, "Bad" 

otherwise.
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Excel AND / OR functions in one formula

Naturally, nothing prevents you from using both functions, 

AND & OR, in a single formula if your business logic requires 

this. There can be infinite variations of such formulas that 

boil down to the following basic patterns:

=AND(OR(Cond1, Cond2), Cond3)

=AND(OR(Cond1, Cond2), OR(Cond3, Cond4)

=OR(AND(Cond1, Cond2), Cond3)

=OR(AND(Cond1,Cond2), AND(Cond3,Cond4))
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Excel AND / OR functions in one formula

For example, if you wanted to know what consignments of 

bananas and oranges are sold out, i.e. "In stock" number 

(column B) is equal to the "Sold" number (column C), 

the following OR/AND formula could quickly show this to 

you:

=OR(AND(A2="bananas", B2=C2), AND(A2="oranges", 

B2=C2))
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Excel AND / OR functions in one formula

And in an Excel sheet…
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OR function in Excel-conditional formatting

=OR($B2="", $C2="“)

The rule 

with the 

above OR 

formula 

highlights 

rows that 

contain an 

empty cell 

either in 

column B 

or C, or in 

both.
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Sorting

Let’s watch the video:

https://www.youtube.com/watch?v=h2kEut1xsMU
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Data validation
Add data validation to a cell or a range

1. Select one or more cells to validate.

2. On the Data tab, in the Data 

Tools group, click Data Validation.

3. On the Settings tab, in the Allow box, 

select List.

4. In the Source box, type your list values, 

separated by commas. 
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Data validation
Now, instead of typing your list values in 

the data validation Source box, you add 

the name that you just defined, preceded 

by an Equal (=) sign.

5. Make sure that the In-cell 

dropdown check box is selected. 

Otherwise, you won't be able to see the 

drop-down arrow next to the cell.

6. To specify how you want to handle blank 

(null) values, select or clear the Ignore 

blank check box.
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Names and named ranges

To define a name for a cell or cell range on a worksheet:

1. Select the cell, range of cells, or nonadjacent selections that 

you want to name.

2. Click the Name box at the left end of the formula bar.

Name box

3. Type the name that you want to use to refer to your 

selection. Names can be up to 255 characters in length.

Press ENTER.
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Names and named ranges

Define a name by using a selection of cells in the worksheet

You can convert existing row and column labels to names.

1. Select the range that you want to name, including the row or column labels.

2. On the Formulas tab, in the Defined Names group, click Create from 

Selection.

3. In the Create Names from Selection dialog box, designate the location that 

contains the labels by selecting the Top row, Left column, Bottom row, 

or Right column check box. A name created by using this procedure refers 

only to the cells that contain values and does not include the existing row and 

column labels.
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Protecting worksheets

You can lock for editing:

- Formulas: If you don’t want other users to see 

your formulas, you can hide them from being 

seen in cells or the Formula bar. For more 

information, see Hide and protect formulas.

- Ranges: You can enable users to work in 

specific ranges within a protected sheet. For 

more information, see Lock or unlock specific 

areas of a protected worksheet.
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Protecting worksheets

Step 1: 

Unlock any cells that needs to be editable

In your Excel file, select the worksheet tab that you 

want to protect.

Select the cells that others can edit.

Right-click anywhere in the sheet and select Format 

Cells (or use Ctrl+1, or Command+1 on the Mac), 

and then go to the Protection tab and clear Locked.
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Protecting worksheets

Step 2: Protect the worksheet

On the Review tab, click Protect Sheet.

In the Allow all users of this worksheet to list, select 

the elements you want people to be able to change.

Optionally, enter a password in the Password to 

unprotect sheet box and click OK. Reenter the 

password in the Confirm Password dialog box and 

click OK.
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Create your spreadsheet

EUPANEXT_LO_112_M_01
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Revision questions

• Identify the functionalities of a 
spreadsheet  that are necessary for the 
production or amendment of complex 
spreadsheets 

• List more advanced  formulas and 
functions that can be used to manipulate 
data 

• Describe the process of protecting a 
spreadsheet

• List criteria for the evaluation of the result 
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• Excel spreadsheets organize 
information

• Formulas and Functions

• What if analysis

• And & or functions
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